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Preface 
 

CAD stands for Computer Aided Drafting. Like all other technical fields, in drafting 

computer have brought revolution. CAD has not only reduced the time spent for drafting to a 

fraction, of that the same produced by hand drawings, but also any revisions in the drawing 

can be done quickly without having to redraw everything. Moreover, different views, such as 

front view, side views etc. can be easily created from the drawing. To use CAD software 

efficiently, it is necessary to know all drafting tools to have a good control over the work. 

This lab manual intends to guide the students to know the fundamental tools to create, modify 

and manage documentation effectively through a skillful way. 

 

Writing a manual is an all-encompassing and time consuming project and author would like 

to thank Prof. Dr. Md. Mahmudur Rahman for his proper guidance and also acknowledge 

AutoCAD User Guide as the major source of the information presented in this manual. 
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Chapter 1 

Computer Aided Drafting (CAD) 

 

 The use of computer technology for the process of design documentation (i.e. 

drafting). 

 CAD may be used to draft in 2D or 3D space. 

2D User Interface (AutoCAD 2007) 

 

 

 

Figure 1.1: 2D User Interface 

 

 

 

 

 

Drop Down Menu 
Standard Tool Bar Style Tool Bar 

Properties Tool Bar Layer Tool Bar 

Cursor 

Modify Tool Bar 

Draw Tool Bar 

Axis 

Command Bar 

Coordinates Status Bar 
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Chapter 2 

Drawing, Editing and Dimensioning 

 

Drop-Down Menu: All options of AutoCAD can be accessed 

from this menu. 

Standard Tool Bar: Shows copy, cut, paste, save, zoom icons. 

Style Tool Bar: Shows current text style, dimension style, table 

style.  

Layer Tool Bar: Shows current layer name. 

Properties Tool Bar: Shows color, line type, line weight. 

Draw Tool Bar: Shows line, rectangle, circle icons. 

Modify Tool Bar: Shows modification icons.  

Command Line: Shows activated command. 

 

Frequently Asked Questions 

How to bring a toolbar on user interface? 

 Right click on any toolbar (i.e. Draw) 

 Select required toolbar (i.e. Dimension) from list (Shown 

in the figure)  

 Set the position of the toolbar (click at the double line 

border and drag it) 

How to Change workspace from 3D to 2D or vice versa? 

 Press “Tools” 

 Select “Workplaces” 

 Select “ 3D modeling” or “AutoCAD classic” 

 

                       

                                                                                                                                                                  

Figure 2.1: List of all tool bar       

 

 

How to start and terminate commands in AutoCAD? 
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 Three ways to start a command (i.e. Line) 

1. From Drop Down Menu ( Draw > Line) 

2. From Command line with short key (Type “ l ” in the command line and press 

“Enter”) 

3. From Toolbar (Click on the line command icon on the draw toll bar) 

 Press “Esc” button on keyboard to terminate any command. 

How to start and complete a drawing? 

 Set drawing unit (Format > Unit) 

 Create  text styles (Format > Text Style) 

 Create dimension style (Format > Dimension Style) 

 Create new layers (Format > Layer) 

 Draw and modify objects (Use Draw and Modify toolbar or menu) 

 Provide dimensions ( Use dimension toolbar or menu) 

 Write texts (Use draw toolbar or menu) 

How to save a file? 

 Click “File” on Drop Down Menu bar 

 Click “Save as” 

 Select “Drive” to save 

 Rename file name only (keep .dwg as extension) 

 Press “Save” 

 

Or 

 

 Press “Ctrl” + S 

 Select “Drive” to save 

 Rename file name only (keep .dwg as extension) 

 Press “Save” 

How to plot a file? 

  Press “Ctrl” + P 

 Select printer name / DWG to PDF.pc3 (Use “Printer name” to print and DWG to 

PDF to publish as pdf) 

 Select paper size  

 Check “Fit to paper” 

 Check “Center the Plot” 

 Press more option (if necessary)  

 Select Plot style table (None is ok. Select Monocrome.ctb for black and white 

print) 

 Select quality 

 Select drawing orientation 

 Press “Preview” 

 Press “Plot” 

Why one may use polyline?  
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        Polylines have some unique qualities that make them very useful: 

 Polylines drawn under one single command can be selected by single click. 

 They can have width (constant or varying) 

 They can consist of arcs and lines 

 They can be edited 

 They can be joined together. 

 They can be exploded into individual segments 

 Especially useful for 3D drawing 

 

How to cancel the last command? 

  Press “undo” button on standard toolbar  

 Or 

  Press “Ctrl” + “Z” 

The X-Y Co-Ordinate System 

The UCS Icon 

 
Figure 2.2: X-Y Co-ordinate 

 

In the bottom left corner of the AutoCAD drawing window you will see a symbol like one 

shown in top. This is called the UCS (User Co-ordinate System) icon and it is there to remind 

you which is the X axis and which is the Y axis. In AutoCAD, there are two co-ordinate 

systems: 

 World Co-ordinate System: A fixed system. 

 User Co-ordinate System: A movable system. 

You can relocate the user co-ordinate system using any of these methods: 

 Move the UCS by defining a new origin. 

 Align the UCS with an existing object or with the current viewing direction. 

 Rotate the current UCS around any of its axes. 

 Restore a saved UCS. 

 

 

 

Using Co-ordinate 
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                                                                                 +ve quadrant 

 

          (0,0) 

                                                  -ve quadrant      

 

Figure 2.3: Co-ordinate System 

Co-ordinates fall into two types, namely Cartesian and Polar. In addition, these two co-

ordinates types come in two distinct flavors. They can be absolute and relative. 

Cartesian Co-ordinates 

Despite the fancy title, the Cartesian co-ordinate system is the standard co-ordinate system. 

The position of a point can be described by the distance from the axes, X and Y. This results 

in a simple point description using two numbers separated by a comma e.g. 34.897, 45.473. 

                                                            Y Axis   

 34.897,45.473  

 

    X Axis 

 

 

Figure 2.4: Cartesian Co-ordinate System 

Polar Co-ordinate System 

Polar co-ordinates achieve the same result i.e. the description of the position of a point. The 

main difference is that polar co-ordinates use one distance and one angle to describe the 

position of a point rather than the two distances in the Cartesian system.  The distance and 

angle measured relative to an origin. This results in a point description which looks like this 

34.897<30 where the first figure is the distance and the second is the angle. 

                    Y Axis     

                                                                                                  (35.8, 60) 

 

  X Axis 

  

 
                                       Figure 2.5: Polar Co-Ordinate System 

Object Selection 

Before you start to use your AutoCAD commands, you need to know something about 

selecting objects. All of the modify commands require that you make one or more object 
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selections. AutoCAD has wide range of tools which are designed to help you select just the 

object you need.  

1. Selecting Object by Picking 

Perhaps the most obvious way to select an object is simply to pick it. To select an object, 

place the pick-box over a part of the object and left click the mouse. When the object has 

been picked, it is highlighted in a dashed line to show that it is part of the current selection 

and the command line reports “1 found”.   

 

Figure 2.6: The Pickbox 

2. Window Selection 

The window option is invoked by typing W in response to the “select objects” prompt. 

Window allows you to define a rectangle using two points in exactly the same way as the 

RECTANGLE command. Once all objects which lie within the window will be selected. 

 

Figure 2.7: The Window selection box is shown as a rectangle with a solid line 

3. Crossing Window Selection 

The crossing window option is invoked by typing C at the “Select objects” prompt and is 

variation of the Window command. The command sequence is exactly the same but objects 

are selected which lie within the window and those which cross the window border. 
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Figure 2.8: The Crossing Window selection box is shown as a rectangle with a broken line 

4. Selecting All Object 

The All option is invoked by typing ALL at the “Select objects” prompt. You can use this 

option to select all the objects in the drawing, no picking is required. Objects on Locked or 

Frozen layers are not selected but objects on layers which are simply turned off are selected. 

5. Using Previous Selection 

AutoCAD always remembers the last selection set you defined. This is very useful because 

you may need to make a number of changes using different commands to the same group of 

objects. In order to reselect the last selection, you can use the previous selection. The 

previous option is invoked by typing P at the “Select objects” prompt. 

6. Selecting the Last Object 

You can select the last object created by entering L at the “Select objects” prompt. 

 
Units and Scales 

Introduction:  
Among the most important concepts that newcomers to AutoCAD need to get to grips with 

are those of drawing scale and units. You cannot start crating sensible drawings with 

AutoCAD until you are familiar with scale, units and commands you use to control them.  

Units Control: 

Command line: Type UN (units) and press Enter 

Format menu: Units 

Figure 2.9: Drawing Unit Selection 
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Toolbar: none 

When you start the Units command, the first thing you see is the Drawing Units dialogue box. 

The dialogue box is divided into four main sections: 

Length: You can see from the dialogue box that there are five different linear unit types for 

you to choose from, one of which is “Decimal”, the default. The table shows the effect of the 

different unit settings on two drawing unit values to give you an idea how various settings 

must be used along with a brief description. 

Table 1: The effect of different unit settings on two drawing unit values with description 

Unit type 1.5 Drawing Units 1500 Drawing Units Description 

Decimal 1.5000 1500.0000 Metric or SI units 

Scientific 1.5000E+00 1.5000E+03 Decimal value raised 

to a power 

Engineering 0’-1.5000” 125’-0.0000” Feet and decimal 

inches 

Architectural 0’- 1 ½” 125’-0” Feet and fractional 

inches 

Fractional 1 ½ “ 1500 Whole numbers and 

fractions 

  

Notice that when you change the unit type, the co-ordinate display on the status bar changes 

to show co-ordinates using the current unit type. Units such as “Architectural” and 

“Engineering” are mainly for AutoCAD users where Feet and inches are still in common use. 

Angles: Looking at the Drawing Units dialogue box again, you will notice that there are also 

five angular unit types. The default is decimal degrees, but there are other options. The table 

below shows the effect of the different unit types on two angular unit values. 

 

Unit type 12.5 Angular units 180 Angular Units Description 

Decimal Degrees 12.500 180.000 Metric units 

Deg/Min/Sec 12d30’0” 180d0’0” Degrees, Minutes 

and Seconds 

Grads 13.889g 200.000g 400 grads=360 

degrees 

Radians .218r 3.142r 2 Pi radians= 360 

degrees 

surveyor N77d30’0”E W Compass bearings 
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 Figure 2.10:  Direction Control 

AutoCAD also allows you to control the direction in which angular units are measured and 

the position of the start angle. AutoCAD starts with the zero angle at the 3 o’clock position 

(East) with angles increasing in an anti-clockwise direction. This case may be changed for 

other modes.  

Drawing Units for Design Center Blocks: Allows you to assign a specific unit to the 

drawing so that when blocks are inserted via the AutoCAD Design Centre, they will 

automatically be scaled. 

Sample output: Gives you a preview of the drawing units as they will be displayed using the 

current settings. 

Unit Precision 

The Drawing Units dialogue box can also be used to set the precision of linear and angular 

units. By default, AutoCAD sets the linear unit precision to four places of decimal, so appear 

in the form 0.0000. Angular unit precision is set to whole degrees only.To change the 

precision with which linear and angular values are displayed, simply click the down arrow 

against the appropriate drop-down list and select the number of decimal places required. The 

default setting of four decimal places is usually adequate for linear units. It is, however, often 

necessary to change the precision for angular units. Working in whole degrees does not 

usually give an adequate level of detail for many drawing functions. However, you do not 

need to change the precision of either linear or angular units unless you have a specific reason 

for doing so. 

Changing the unit precision does not make your drawing more accurate, it just means that the 

co-ordinate display on the status bar and the results from the various inquiry commands will 

be displayed with a higher degree of precision. The accuracy of your drawing will be 

determined by the values you enter for the size of objects when you draw and edit them and 

by the correct use of the various object snaps and drawing aids.   
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Zoom (Standard Tool Bar) (z) 

1. Pan real time: Move display.  

2. Zoom real time: Increase or decrease display 

size. (Use mouse scroll as alternative) 

3. Zoom window: Enlarge the part of the drawing 

4. Zoom previous: Returns to the last Zoom view. 

 

N.B.: To bring all drawings on screen use zoom all (Z A ). 

 

Status Bar 

 

1. ORTHO (Ortho mode)  
 Click on “ORTHO” button on Status bar or Press F8 

 Enforces to draw horizontal or vertical lines only 

 

2. OSNAP (Object snap) 
 Click on “OSNAP” button on Status bar or Press F3 

 Right click on “OSNAP” button on Status bar 

 Press “Setting” 

 Check desired object snap options 

 Press “ok” 

 Helps to snap (grip) different points during drafting 
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Figure 2.11: Available snap options. 

3. DYN (Dynamic Input) 
 Click on “DYN” button on Status bar or Press F12 

 Shows command line with cursor during execution of any command 

 

4. LWT (Line weight) 
 Click on “LWT” button on Status bar 

 Shows line thickness 

Draw Toolbar  

 

1. Line (l) 

 
a. By picking two points 

 Specify first point (click at any point) 

 Specify next point (click at any point) 

                                      Or 
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b. By direct distance entry 

 Specify first point (click at any point). 

 Input length (type length of the line) 

 Press “Tab” on the keyboard  

 Input angle (type angle with the X axis) 

 Press enter(  )  on the keyboard 

 

Horizontal or vertical line  

 Specify first point (click at any point) 

 Press “ORTHO” in status bar or press F8 on keyboard. 

 Input length (type length of the line) [Keep the cursor appropriately] 

 Press enter(  )  on the keyboard 

 

2. Rectangle (rec) 
 

a. By picking two points 

 Specify first corner point (click at any point) 

 Specify other corner point (click at any point) 

                                   Or 

b. By direct distance entry 

 Specify first corner point (click at any point) 

 Input length along X (type length of the rectangle) 

 Press “Tab” on keyboard  

 Input width along Y  (type width of the rectangle) 

 Press enter(  )  on the keyboard 

 

3. Circle (c) 
 Specify center point (click at any point) 

 Input radius of the circle (type radius of the circle) 

 Press enter(  )  on the keyboard 

                                      Or 

 Specify center point (click at any point) 

 Type d  

 Press enter(  )  on the keyboard 

 Input diameter of the circle (type diameter of the circle)  

 Press enter(  )  on the keyboard 

 

4. Arc (a) 

To draw an arc three points on the arc are necessary. The choice of these points depends 

on the user or availability of defined points. AutoCAD by default draw arc anticlockwise. 

So select start and end points properly to get the desired arc shape. 
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Figure 2.12: Start point and end point of arc 

             Table 2: Table for available options of arc and its steps 

Available options Steps 

Center, Start, End 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Specify end point of the arc (Click at the end point of 

the desired arc) 

Start, center, end 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Specify end point of the arc (Click at the end point of 

the desired arc) 

Start, Center, Angle 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Input angle (Angle of end point with X axis at center) 

Start, End, Radius 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type e 

 Press enter(  )  on the keyboard 

 Specify end point of the arc (Click at the center point 

of the desired arc) 

 Type r 

Start point

End point

End point

Start point
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 Press enter(  )  on the keyboard 

 Input radius. (type radius of the desired arc) 

Special note: 

 For simplicity use polyline to draw arc. 

 

5. Donut (do) 
 Input inside diameter (generally zero (0)) 

 Press enter(  )  on the keyboard 

 Input outside diameter ( choose a value based on your drawing )  

 Press enter(  )  on the keyboard 

 Specify center of donut (click at points where donuts are necessary) 

 

6. Polygon (pol) 
 Input number of sides 

 Specify center of polygon (click at point) 

 Select an option 

 Inscribed in circle 

 Circumscribed about circle 

 Input radius of circle 

 

 
               Inscribed in circle                                Circumscribed about circle 

 

Figure 2.13: Polygon 

7. Ellipse (el) 
 Specify first point of major axis (click at point) 

 Specify endpoint of major axis (click at point) 

 Input distance from the midpoint of the first axis to the endpoint of the minor 

axis 
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Figure 2.14: Ellipse 

8. Region (reg) 
 Select objects ( lines intersect at end points are appropriate objects) 

 Press enter(  )  on the keyboard 

 

 

 

 

 

 

 

 

Choice of objects 

 
Appropriate 

 
Not appropriate 

 

9. Hatch (h) 

 

 

 

 

 

 

Major axis

First point

M
in

o
r ax

is

D
is

ta
n

ce

End point
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Figure 2.15: Hatch Properties Manager 

 Use predefined type 

 Choose the desired pattern ( i.e. concrete, brick etc) 

 Choose angle (Change the orientation of the hatch lines but default is 

recommended)  

 Input scale value (Large value lightens the hatch and small value densifies 

hatch) 

 Choose appropriate boundary selection option 

 Add pick points: Click at any point in a closed boundary (does not 

work if any gap on the boundary) 

 Add select objects: Select objects (objects may or may not create 

closed boundary 

 Press enter(  )  on the keyboard 

 Choose option 

 Check “ Associative” option to allow modification of hatch shape with 

the boundary shape 

 Check “Create separate hatches” option to create separate hatches in 

case of multiple boundary selection 

 Press “Preview” 

 Observe hatch created 

 Press enter(  )  on the keyboard 

 If obtain desired hatch press “ok” or Change parameters and repeat from 

preview. 

Angle and Scale Type 

Angle            0                     0                    0 

            
Angle           45                   90                 135 

 
Concrete         Brick            Sand 

 
Brick          Grass            Gravel 

 

         
Scale             1                    5                   10 
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Figure 2.16: Hatching options 

 

 

 

 

Choice of boundary selection  

 
    “Add pick points” 

 Or  “Add select objects” 

 
“Add select objects” 

 

Figure 2.17: Choosing Area to be Hatched 

Special Notes:  

 One can choose more than one boundary at a time to create hatch (use separate 

option for convenience). 

 One can modify any hatch by double clicking. 

 Choose proper island style [if necessary]. Any enclosed area inside the hatch 

boundary is island. 

 

 
Island style :                  Normal                          Outer                          Ignore 

 

 

Hatch boundary
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Figure 2.18: Island Style 

10.  Text (t) 
 Draw small window 

 Select text style and font (if necessary) 

 Choose text height 

 Write on the shaded box 

 Press enter(  )  on the keyboard to go next line (if necessary) 

 Press “ok” 

Special Notes:  

 One can modify text by double clicking. 

 One can underline a sentence or make a word bold etc. 

 One can insert symbol ( use @ icon) 

 One can insert fraction or subscript or superscript. 

 Command Output 

Superscript 

 Type   X2^ 

 Select  2^ 

 Press “Stack ( 
 

 
 )” icon 

X
2 

Subscript 

 Type    X^2 

 Select   ^2 

 Press “Stack ( 
 

 
 )” icon 

X2 

Fraction 

 Type   X/Y 

 Select X/Y 

 Press “Stack ( 
 

 
 )” icon 

 

 
 

 

 

11.  Block  

 
  

Figure 2.19: A dining table as block 

a. Insert block (i) 

 Browse (C:\Program Files \AutoCAD 2007 \Sample\Design center\ House 

designer) 

 Check explode 
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 Press “ok” 

 Specify insertion point for block (click at any point of window) 

 Zoom all to see blocks 

 

 

b. Make Block (b) 

 Draw an object  

 Define a name to the block 

 Input base point (Press pick point and click at any  point closer to the object) 

 Select object ( select the desired object to make block) 

 Press enter(  )  on the keyboard 

 Check “Convert to Block” 

 Choose appropriate block unit 

 Press “ok” 

 Keep the file for further use as block 

Modify Toolbar 

 

1. Offset (o) 
 Input offset distance (perpendicular distance between parallel lines) 

 Press enter(  )  on the keyboard 

 Select object ( only one line can be selected) 

 Specify point on side to offset ( select any side of the line) 

 

 

2. Copy (co or cp) 
 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point 

 Specify second point or input distance (horizontal or vertical or inclined) 

 

3. Move (m) 
 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point 

 Specify second point or input distance (horizontal or vertical or inclined) 

 

4. Rotate (ro) 

AutoCAD by default considers anticlockwise rotation as positive. So to rotate clockwise 

one should assign negative angle. 

 Select object or objects 

 Press enter(  )  on the keyboard 
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 Specify the base point 

 Input angle ( angle with X axis) 

 

5. Mirror (mi) 
 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify first point of the mirror line 

 Specify second point of the mirror line 

 Press enter(  )  on the keyboard 

 

6. Extend (ex) 
 Select line or lines as boundary edge ( Right click mouse to select all lines as 

boundary edges and skip next step) 

 Press enter(  )  on the keyboard 

 Select end of the object or objects closer to boundary edge to extend  

 

 

7. Trim (tr) 
 Select line or lines as cutting edge ( Right click mouse to select all lines as 

cutting edges and skip next step) 

 Press enter(  )  on the keyboard 

 Select object or objects to trim  

 

Special Notes: 

 Hold “Shift” key to alter trim and extend command. 

 

8. Array (ar) 
a. Rectangular array 

 Input number of row and column 

 Input row and column offset (Offset means c/c distance of rows or columns ) 

 Input angle of array (if necessary) ( indicates the angle of row with positive x 

axis) 

 Select object  

 Press enter(  )  on the keyboard 

 Press “Preview” 

 Observe the array created 

 If obtain desired array press “accept” otherwise press “Modify” and repeat 

steps 
 

b. Polar array 

 Specify center point  

 Choose appropriate method of array (i.e. choose any two parameter from total 

no. of item, angle to fill and angle between item) 

 Input parameter values 

 Total no. of items: Input number of items to be considered as array 

element 
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 Angle to fill: Input angle to be filled up by the array elements 

 Angle between items: Input angle between array elements at center of 

the circle. 

 Check/uncheck rotate items as copied (allow/disallow the rotation of array 

elements) 

 Select object  

 Press enter(  )  on the keyboard 

 Press “Preview” 

 Observe the array created 

 If obtain desired array press “accept” otherwise press “Modify” and repeat 

steps 

 

9. Scale (sc) 
 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point  

 Type scale factor (Greater than 1 to enlarge and less than 1 to shrink 

proportionally) 

 Press enter(  )  on the keyboard 

 

10.   Stretch (s) 
 Select object or objects (select only by crossing window) 

 Press enter(  )  on the keyboard 

 Specify the base point  

 Type distance (the distance of the base point movement) 

 Press enter(  )  on the keyboard 

 

11.  Fillet (f) 
 Type r ( to input radius first)   

 Press enter(  )  on the keyboard 

 Input radius 

 Press enter(  )  on the keyboard 

 Select the first object (line) 

 Select the second object (line) 

       Special Notes: Use Fillet + “Shift” key to get 

sharp corner. 

 

12. Chamfer (cha) 

 Type d ( to input distance first)  

 Press enter(  )  on the keyboard 

 Input first chamfer distance 

 Press enter(  )  on the keyboard 

 Input second chamfer distance 

 Press enter(  )  on the keyboard 

 Select the first object (line) 

 Select the second object (line) 

Radius

Chamfer distance

C
ha

m
fe

r d
is

ta
nc

e
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13. Explode (x)                                                                  Figure 2.20: Chamfering 

 Select object 

 Press enter(  )  on the keyboard             

  

14.  Match properties (ma) 
 Select source object 

 Select destination object or objects 

                                                                                         

Grips: Important Modification Tool 

 Grips are those dots appear at the endpoint and midpoint of a line after selection. 

 

 

 

 

 

 

 

Unselected 

Grip 

(Blue) 

 
 

(Just after selection) 

Hover Grip 

(Green) 

  
(Just after keeping the cursor on the grip) 

Selected 

/Hot Grip 

(Red) 

  
(Just after clicking on the grip) 

 

Table 3: Table for various command 

Action Command appears Result 

Click on any end point Stretch Activate Stretch command 

Click on the midpoint Move Activate Move command 

Press “Ctrl” + click on the 

midpoint 

(Hold “Ctrl” until make one copy) 

Copy Activate Copy command 
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Click on any point then press 

“Enter” 
- 

Change from Stretch to Move, 

Rotate, Scale and Mirror 

Press “Shift” + click on any point 

 
- 

Allow to select multiple grips  

 

Format Tab 

1. Unit  
 Choose appropriate unit system as drawing unit 

 Choose proper precision 

 Choose insertion scale (Unit of any value inserted without unit (i.e. ft/inch/mm 

etc.)) 

 

2. Text Style  

 Press “New” 

 Define style name 

 Specify font name (i.e. Times New Roman) 

 Choose a height  

 Press “Apply” 

 Press “Close” 

 

3. Dimension Style  
 Press “New” 

 Define new style name 

 Press “continue” 

 Press “ Symbol and arrows” tab 

 Select first and second arrow head 

 Press “ Text” tab 

 Choose text style 

 Press “ Fit” tab 

 Set use overall scale of ( Large value enlarges dimension text) 

 Press “ Primary Unit” tab 

 Choose unit format ( Generally same as Drawing Unit ) 

 Choose proper precisions (Generally same as Drawing Unit ) 

 Zero suppression ( Don’t show 0’ or 0” etc) 
 Suffix  ( if necessary to show something as suffix of the dimension text) 

 Prefix ( if necessary to show something as prefix of the dimension text) 

 Scale factor (if necessary to multiply dimensions with any value) 

 Press “ ok”  

 Select dimension style created 

 Press “Set Current” 

 Press “Close” 

 

4. Layer  

 Press “New layer” 

 Double click and rename “Layer Name” 

 Click and choose color 



Department of Civil Engineering  
AUST 

                                                             

 
CE 102: Computer Aided Drafting  

Page | 24  
 

 Click and choose line weight 

 Click on line type 

 If new line type is needed press “Load” 

 Choose a line type 

 Press “ok” 

 Select the loaded line type and press “ok” 

 Repeat steps to create more layers 

 Press “ok” 

 Special Notes: 

 New objects are drawn automatically with current layer. 

 One can change objects layer manually from layer toolbar. 

 When a layer is on, it is visible and available for plotting. When a layer is off, it 

is invisible and not plotted, even if Plot is on.  

 If plotting is off for a layer, the objects on that layer are still displayed but will 

not be plotted. 

 Objects on a locked layer cannot be modified. 

 Objects on frozen layers are not displayed, plotted or regenerated. 

 If dashed lines are not visible then change line type scale  

 Type “ ltscale ” 

 Press enter(  )  on the keyboard 

 Input scale factor ( larger value make the gap visible) 

Dimension Toolbar 

 

1. Linear  

 Click at the first extension line origin 

 Click at the second extension line origin 

 Click to fix dimension line location 

 

Dimension Line

E
x

te
n

si
o

n

L
in

e

E
x

te
n

si
o

n

L
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e

Extension

Line origin

Extension

Line origin
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Figure 2.21: Linear Dimension 

2. Aligned  

 Click at first extension line origin 

 Click at second extension line origin 

 Click to fix dimension line location 

 

3. Continue  

 Continue from last dimension 

 Click at only second extension line origin and so on                           

             Or 

 Continue from any dimension 

 Types (to select a dimension) 

 Press enter(  )  on the keyboard 

 Select desired dimension 

 Click at only second extension line origin and so on 

 

4. Angle  
 Select the first line  

 Select the second line  

 Click to fix dimension line (arc) location 
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5. Radius  
 Select circle  

 Click to fix dimension line (leader) location 

 

6. Diameter  

 Select circle  

 Click to fix dimension line (leader) location 

 

7. Quick Leader  
 Click at first leader point 

 Click at next point of leader 

 Click at next point of leader (if necessary) 

 Input text width (default is ok) 

 Press enter(  )  on the keyboard 

 Type first line of annotation text 

 Press enter(  )  on the keyboard 

 Type second line of annotation text (if necessary, otherwise skip) 

 Press enter(  )  on the keyboard 

 

8. Dimension Text Edit  
  Select dimension  

 Click at desired location to set dimension text 

 

9. Dimension Edit  
 Press “New” 

 Select and delete “ 0” ” 

 Type desired dimension with unit or text 

 Press “ok” 

 Select dimension to be changed 

 Press enter(  )  on the keyboard 

                                          Or  

 Type “ddedit” 

 Press enter(  )  on the keyboard 

 Select existing dimension and delete 

 Type desired dimension with unit or text 

 Press “ok” 

Miscellaneous commands 

 

1. Polyline (pl) 
 Specify first point (click at any point) 

 Specify next point (click at any point) 

                                      or 

 Specify first point (click at any point). 

 Input length (type length of the line) 
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 Press “Tab” on the keyboard  

 Input angle (type angle with the X axis) 

 Press enter(  )  on the keyboard 

        Special note 

 You can draw arc, line with certain width using polyline. For this just look at the 

command line. 

 

2. Multiline (ml) 
 Press “s” to input parallel line distance 

 Press enter(  )  on the keyboard 

 Press “j” to select zero (centerline)/top/bottom length 

 Press “z” or “t” or “b” 

 Press enter(  )  on the keyboard 

 Specify first point (click at any point) 

 Input length (type length of the line) 

 

3. Divide (div) [Draw > Point > Divide ] 
 Select object to divide 

 Input number of  segments 

 Press enter(  )  on the keyboard 

 

Special notes: 

 To see the points on the line, create point style 

 Format > Point style > Choose point icon > ok 

 

4. Measure (me) [Draw > Point > Measure ] 
 Select object to measure 

 Input length of  segments 

 Press enter(  )  on the keyboard 

Special notes: 

 To see the points on the line create point style 

 Format > Point style > Choose point icon > ok 

 If total length is not a multiple of the length of segments then AutoCAD 

measures segments from the left side. Right most segment will be the remainder. 

 

5. Align (al) 
 Select objects 

 Press enter(  )  on the keyboard 

 Specify first source point 

 Specify first destination point 

 Specify second source point 

 Specify second destination point 

 Press enter(  )  on the keyboard 
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 Scale objects based on alignment points? 

 Yes (distribute and scale objects within the destination points) 

 No ( only align objects without scaling) 

 
Scale objects based on alignment points (Yes) 

 
Scale objects based on alignment points (No) 

 

Figure 2.22: Dimensioning Along Align Plane 

6. Group (g) 

a. Create group 
 Type group name 

20'

5'

First Destination

point

Second Destination

point

20'

2'-6"

First Destination

point

Second Destination

point
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 Press “New” 

 Select desired objects 

 Press enter(  )  on the keyboard 

 Check “selectable” 

 Press ok 

b. Modify group 

 Select group name 

 Pick desired edit option (remove or add objects or explode)  

 Select desired objects 

 Press enter(  )  on the keyboard 

 Press ok 

 

6. Oops (oops) 
 Type “oops” in command bar 

 Press enter(  )  on the keyboard 

Special Notes: 

 This command restores the last deleted item only even you use other command 

in between. 

 Different from undo option because it (undo) only cancel last command. 

 

7. Wipeout (wipeout) 
 Type “wipeout” in the command bar  

 Draw any shape to clean hatch pattern 

 Press enter(  )  on the keyboard 

Important Control Keys 
 

Control Keys Result 

CTRL+8  Launches calculator window 

CTRL+A Select all 

CTRL+N Create new drawing 

CTRL+P Opens the plot dialogue box 

CTRL+S  Opens the save dialogue box 

CTRL+Z  Undo  the last operation 

CTRL+TAB  Switches between open drawings 

Esc Cancel command 

 

Object Properties 
 
Every AutoCAD, such as or a line or a circle has properties. Some properties such as color, 

Line type and Layer are common to all objects. Some object have properties which are 

specific to themselves. Text, for example, is the only object type which has a style property. 

In AutoCAD Release 14, the easiest way to control object properties is to use the object 

Properties toolbar, illustrated below. This is one of AUTOCAD,s default toolbars and can 
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usually be found directly below the standard toolbar in the top left hand corner of the 

AUTOCAD window.  
 

 
 

Take time to work through this tutorial, it is particularly important to get to grips with object 

properties since it can make the difference between a really good AUTOCAD drawing and a 

really terrible one. If you just need information quickly, use the Quick Find toolbar below to 

go straight to the information you need or select a topic from the contents list above. 

 

 

Layers 

Probably the most important object property to understand well is the layer property. 

Experienced AutoCAD users use layer all the time and that is why the object properties 

toolbar contains so many layer function. Good use of layer is the most important aspect of 

good drawing practice. 

 

 

The concept of layer is very important in AUTOCAD and the correct use of layer can make 

your drawing   much easier to work with. Basically, layers are the computer equivalent to 

tracing overlays on a drawing board. However, layers are much more powerful because you 

can have many layers in a single drawing and you can control the visibility, color and line 

type of layers independently. This makes working with very complicated drawings much 

more efficient. Layers are effectively a way of ordering your drawing. For example, you may 

need to create a number of construction lines in a drawing which will not form a part of the 

finished image. You could create a layer called “Construction” and use this for your 

construction lines. When the drawing is completed, you could simply turn this layer off so 

that it can’t be seen. The beauty is that you can could always turn this layer back on at some 

future time if modifications to the drawing are required. Experienced AUTOCAD uses will 

use layers to order their drawing by drawing components. For example, if you were creating 

landscape master plan, you may have layers called “Trees’’ “Shrubs’’ “Path” etc. The main 

reason for this, apart from it being a simple way to control the drawing, is that the different 

drawing components may need to be printed in different colors with different line type and 

with different line widths. Layers can be used to control the way objected are displayed on 

the computer monitor and how they appear when they are printed. 

 

It is a common misapprehension amongst new users that layer can be used to control the 

visual hierarchy of objects. In other words, if two object overlap, it seems reasonable to 

assume that you could cause one object to display “above” another with the model is 

common to illustration software such as core IDRAW. However, AutoCAD uses a 3 

dimensional drawing space where all object coexist and are position in their correct co-

ordinate locations. The concept of an object being displayed above or below another, 

therefore, is not consistent with this logic. In AUTOCAD the displayed of one object in 

relation to another is determined by the objects place in the drawing database. objects draw 

more recently will display over another if the two objects occupy the same physical space.it is 

possible  to override this effected  Display order tools found on the Tools pull-down, Tolls  
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Display order option these option are particularly useful to control the display of overlapping 

solids and solid hatches that are coplanar. The layer of an object has no its display order, 

 

Although you can have many layers in a drawing, you can only draw on one layer at a time. 

The layer you are drawing on is said to be the current layer. The object properties toolbar 

displays the current layer information. In the illustration above, you can see that layer “0’’ is 

the current layer and that the color and line type are set ‘By layer’’  

 

 

When you start a new drawing, AUTOCAD has only one layer. This layer is special and is 

called layer ‘0’’ (zero).layer 0 is special because you cannot change its name or delete it and 

is has certain properties which we do not need to consider just now. By default layer 0 is 

assigned the color white (color number 7) and this “Continues” line type. Layer 0 is always 

the current layer when start a new drawing, however, it is bad drawing practice to use layer 0 

for normal drawing. The first thing you should do therefore, when you start a new 

AUTOCAD is to create some new layers.  

 

 

The layer command 

 

LAYER (manages or LAYER and layer properties) 

Command line: Type LA or LAYER(layer) and press enter.    

Format menu:     layer......... 

Layers toolbar: pick Layer Properties Manager tool      

Although AUTOCAD provides many shortcuts for working with layer, many of which will 

be covered later, the layer command provides the most comprehensive control over layers 

and layer operations. This command uses a dialogue box. The dialogue box is a tabbed 

dialogue box and can be modified to show more or less details. This is quite nice because in 

its simplified form it looks much less intimidation to beginners. The following sections 

demonstrate how the layer command can used to perform many of the most layer operations. 

 

Creating a New Layer  

 

To create a new layer, click on     in the layer toolbar, the Layer properties Manager 

dialogue box, illustrated below, appears. This is a tabbed dialogue box and can be used to 

control either layer properties depending upon which tab is selected. The layer tab is always 

selected by default. Now click on the ‘New’’ button. A new layer called ‘layer’’ is 

automatically created in the layer list below layer 0. As you can see from the illustration the 

layer name is automatically highlighted for you so that you can give the layer a more 

meaningful name. When you have entered an appropriate name, press      key to complete the 

operation. You have now created a new layer and given it a name. Notice that by default it 

has been assigned the color white and the line type ‘Continues ‘. 

There are a few restriction to consider when you are naming layers. The most annoying is 

that you cannot use spaces within layer names. So, for example, the layer name “ Tree trunk” 

is illegal, However, it is common practice to replace the space with either a hyphen or an 

underscore, both of which are valid layer name character. So, the layer name “Tree trunk” 

and “Tree trunk” are both acceptable. Some other special characters are also not allowed. If 
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you do use an illegal character, Auto CAD will alert you with the error message box 

illustrated above. Notice that it very helpfully tells you which characters are legal. Basically, 

if your stick with letters and numbers you won’t experience any problems. In addition to the 

hyphen and underscore mentioned above, the dollar sign is the only other symbol allowed. 

 

The only other restriction relating to layer names is the number of characters used. Layer 

names can be between one and thirty-one character long. This should give you plenty of 

scope to devise understandable and descriptive names for your layers. It is good drawing 

practice to name your layer sensibly, bear in mind that other people may have to work with 

drawing which you creator. If you enter a layer name longer that 31 characters, Auto CAD 

will display the error message box. 

 

Layers are always listed alphabetically in layer lists, the user has no way to control the list 

order. It is worth bearing this in mind when naming your layers. Keep similar object layers 

together by devising a hierarchical naming structure. For example, if you are drawing a tree 

symbol which comprises a number of elements, your layer names might be, “Tree canopy” 

“Tree text” “Tree trunk” etc. This will cause all the Tree layer to be displayed together, see 

the illustration on the left. This is quite important because in complicated drawing there may 

be many layers and searching for the right group of layers can waste a lot of time. 

 

 

Setting Color and Line type “ByLayer” 

Auto CAD two methods of setting the color and Line type of a drawing object. First of all, 

color and Line type can be set ByLayer. In other words, and object will be displayed in their 

color and Line type of its layer. For example, if your draw a circle on a layer which your have 

called “Details” and you have also set the color of Details to blue and the Line type to 

dashed, then the circle will be display in a dashed blue line. When an object takes on the 

properties of its layer, the color and Line type are said to be set “ByLayer. 

 

The second method AutoCAD offers is to set the color and Line type by object. Setting 

properties by object overrides those set ByLayer. In general it is drawing practice to set color 

and Line type properties ByLayer, this is more efficient and less confusing in the long- run. 

For example, imagine that you have drawn hundreds of objects on the same layer and have 

set their color to green. Later in the drawing process you decide that these objects should, in 

fact, be yellow. In order to make the change you would have to use the Properties command 

and select every one of the objects by picking them. By contrast, if you had set the objects 

color ByLayer, you would only have to change the layer color from green to yellow and all of 

the objects would change. 

 

 

Setting the Color of Layer  

 

It is often convenient to set the layer color when the layer is created. Although this can be 

done at any time. The layer color can be changed as many times as you like. Each time it is 

changed, any objects on that layer will change to the new color, providing their color is set to 

“ByLayer”  
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To set a layer color, open the Layer Properties Manager dialogue box, click on and then click 

on the color icon in the layer list associate with the layer you want. Notice that all layers have 

their own color icon and that this changes to display the layer color. Clicking on the icon 

brings up Select Color dialogue box, shown on the right. You can select nay of the 255 

standard AutoCAD colors by picking on the color palette or by entering the color name or 

number in the text edit box. When you have selected the color you want, click on th “OK”  

button to set the color. AutoCAD uses only 255 color plus the drawing background color, 

irrespective of the capability you video display. 

 

                               
 

Figure 2.23: Selecting Line Color 

 

Assigning different colors to your layers will make working with complex drawings much 

easier. You will be able to see at a glance what a particular line represents. For example, your 

construction lines may be on a layer called “Construction” and have the color yellow. This 

will visually differentiate these lines from lines on other layers with different colors. 

 

 

Setting the Line type of a Layer 

In the same way that you can assign a color to a layer you can also assign a Line type to a 

layer. For example, you could have all the lines. To set a Line type to layer, click on    and 

then click on the current Line type name associated with your layer in the layer list. By 

default, layer have the “Continuous” Line type. Clicking on the line type name brings up the 

Select Line type dialogue box, shown on the bottom. You will notice that the “Continue” 

Line type is the only one listed. That’s because all Line types, except “Continue” are stored in 

an external file and have to be loaded before they can be used. 
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Figure 2.24: Selecting Line Type 

 

Loading Line type 

To load a Line type, click on the “Load....” button in the Select Linetypye dialogue box. The 

Load of Reload Line type dialogue box appears and display list of the available Line types. 

Select as many of the listed Line types as you wish and then click the OK button to return to 

the Select Linetpye dialogue box. 

 

                          
 

Figure 2.25: Loading Line Type 

 

Selecting from list boxes works the same way in AutoCAD as it does in any other Windows 

application. For example, if you wish to select a block Line types from the list at one time, 

select the first Line type in the block, hold the shift key down on the keyboard and select the 

last Line type in the block. All Line types in the block will be highlighted and you can click 

the “OK” button to load them all one go. You can hold the Control (Ctrl) key down on the 

keyboard to make multiple selections which aren’t adjacent in the list (see illustration above). 
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When you return to the Select Line type dialogue box the loaded Line types are display in the 

list. To assign a particular Line type to a layer, simply click on the name to highlight it and 

then click on the OK button, when you return to the Layer & Line type Properties dialogue 

box, the new Line type name will be listed against your layer in the “Line type” column. 

From now on, all object drawn on this layer will be drawn with the chosen Line type. 

However just like colors, you may change the Line type at any time and the objects drawn on 

that layer will automatically be updated to display the new Line type. 

 

Changing Line weight of a Layer  

 

Command line: Type LA (layer) and press Enter () 

 

Format menu:      Layer....... 

 

Layers toolbar: pick Layer Properties Manager tool  

 

Procedure: 

Step1: Input Layer command (any one of above way) [A Layer Properties Manager box will 

appear] 

Step 2: Select a Layer 

Step 3: In the Line weight column, click box on the line weight size of the layer to change 

(Line weight box will appear) 

Step4: Select any Line weight you want and click on Ok button (Line weight box will 

disappear) 

Step 5: Click on OK button again to terminate the command  

 

Making a Layer the Current Layer 

 

Once you have created some layers you will want to start using them. As indicated above, 

you can only draw on one layer at an item. In order to draw on a particulars layer you must 

first make it the current layer. As usual with AutoCAD there are a number of alternatives. 

You could, for example, use the Layer command, Layer... from the Format menu of from the 

Layers toolbar. As you have seen previously, this command brings up the Layer Properties 

Manager dialogue box. To set the current layer, select a layer name from the list and then 

click on the “Current” button and then click the “OK” button to finish. The selected layer is 

now the current layer and its properties are displayed on the Layer toolbar. 

 

Most experienced Auto CAD users change the current so frequently that the method starts to 

seem very long winded. It is much quicker and therefore more efficient to set the current 

layer directly from the layers toolbar using the “Layer Control” drop down list. To set the 

current layer, click on the down arrow next to the layer control window to reveal the layer 

list. Simply click on the name of the layer you wish to make current. If the layer name is not 

visible because the list is quite long, Scroll down the list until you see it. The drop down list 

only display 10 layer at a time. As a beginner, you may feel that this is quite a lot but a 

complex and well structured drawing may have 50 or 100 layers. 
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There is an even quicker way to change the current layer providing you know which layer 

objects are on. You can use the Make Object’s Layer Current command to set the current to 

the layer of any picked object.  

 

Option 1: 

Command Line: Type LA (layer) and press Enter. 

Format menu: Layer 

Layers Toolbar: pick Layer Properties Manager tool. 

Procedure: 

Step 1: Input Layer command (any of the above way) 

Step 2: Select a layer and click on Current button. 

Step 3: Click on OK button to terminate the command. 

 

Option 2: 

Procedure: 

Step 1: Select any object of the layer you want to make current (with-out any command) 

Step 2: Click on the Make Object’s layer Current tool from the Layers toolbar. 

 

 

Option 3: 

Procedure: 
Step 1: From the Layers toolbar, open the layer control drop down menu.  

 
Step 2: Click on the layer’s name you want to make it current. 

 

 

Sending Object from One Layer to Other Layer 

Procedure: 

Step 1: select any object you want to transfer to other layer. 

Step 2: From the Layers toolbar, open the layer control drop down menu. 

 
Step 3: Click on the layer’s name where you want to transfer. 

Step 4: Press Esc button. 

 

Freezing and Thawing Layers 

Freezing and thawing layers works in exactly the same way as turning them on or off. By 

freezing a layer, you can effectively instruct the AutoCAD to ignore the objects on that layer 

when regenerating the drawing. Objects on freezing layers are not displayed or plotted.  

  

 

Locking and Unlocking Layers 

Locking and unlocking layers work as for turning layers off and on and freezing and thawing 

them. Simply click on lock button to toggle an unlocked layer so that it becomes locked and 

click on unlock button to reverse the process.  

 

 

Deleting a Layer 
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To delete a layer, click the name of the layer to highlight it, click the “Delete” button and 

then click “OK”. 

 

 

Setting the Line-type Scale 

In many cases your line-types will display just as you want them. However, it is inevitable 

that at some time you will need to change the scale at which yours line-types are displayed. 

By default the line-type scale is set to 1.0, this means that each line-type pattern will repeat 

every 1.0 drawing units. To make the pattern appear larger, change the scale to a larger 

number. Setting the line-type scale to 5.0 for example causes the line type pattern to repeat 

every 5.0 drawing units so that the pattern will appear 5 times larger. Conversely, setting the 

scale to 0.2 drawing units which will make the pattern appear 5 times smaller. See the 

illustration below. 

 
 

Figure 2.26: Selecting Line Type Scale 

Changing Object Properties 

 

There will be occasions when an object properties will need to be changed. Say, for example, 

you have drawn an object on the wrong layer. It’s much simpler to change the layer for that 

object rather than to erase the object, set the current layer and draw it again. There are a 

number of ways in which an objects properties can be changed but the most common method 

is to use the Properties command. Remember that you cannot change the properties of the 

objects on locked layers. 

 

The Properties Command 

Command Line: Type PR or PROPERTIES and press Enter. 

Modify Menu: Properties 

Standard Toolbar: Pick Properties tool. 

The followings are eight general properties common to all objects: 

 Color 

 Layer 

 Linetype 

 Linetype scale 

 Plot style 

 Lineweight 

 Hyperlink 
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 Thickness  

 

Editing with the Object Properties Toolbar 

 

Although editing object properties using the Properties command is easy enough, AutoCAD 

introduces a new and more efficient way to modify the Layer, Color, and Line-type of an 

object. By using the Object Properties Toolbar, the layer, color, line-type of an object or 

objects can be modified directly, without the use of a command. 

 

The Match Properties Command  

Another way to change the properties of an object or object is to match the properties of any 

other object using the Match Properties command on the standard toolbar. 

Command line: Type MATCHPROP (match properties) and press enter      

Modify menu:    Match Properties  

Standard toolbar: pick Match Properties tool. 

 

Command Sequence: 

Command: MATCHPROP  

Select a source object: (pick the object you wish to match) 

Current active setting: Color Layer Ltscale Line weight THICKNESS PLOTESTYLE Text 

DIM HATCH POLYLINE VIEWPORT. 

Select destination object(S) of [setting]: (pick the objects to inherit properties) 

Select destination objected (s) or [setting] (to terminate the command) 

 

Once the command sequence has been completed, the destination object will inherits all of 

the current active setting which are specific to that object type. You can control which 

properties are matched and which are not by using the ‘setting’’ command line option. 

Changing  

 

Line weight or layer 

 

Command: menu type a layer and press Enter 

 

Format menu: Layer 

Layer toolbar: pick layer Properties Manager 

 

Procedure: 

Step: 1: Input Layer command (any one of the above way) [A Layer Properties Manager box 

will appear) 

Step 2: Select layer  

Select 3: In the Line weight column, click on the line weight   size of the layer to change 

(Line weight) box will appear)  

Select 4: Select any Line weight you want and click on OK button (Line weight box will 

disappear) 

Select 5: Click on OK button again to terminate the command.  

 

 

Tips for Working Faster in AutoCAD 
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Working faster is not simply beneficial for finishing exams by deadlines, but also very 

important to employers for whom efficiency and production speed are critical to business 

success.  

1. At first think about the drawing to indentify centerlines or a starting point. 

2. Try to develop a preference for using commands at the keyboard rather than selecting 

icons in toolbars or items in menus. It is much faster.  

3. Always look at the command line for guidance when you are learning new AutoCAD 

commands. The command line will prompt you for information and this is the easiest 

way to find out how a new command works. 

4. When a command is used, apply it as many times as you can before going on to 

something else.  

5. Press the “Enter” or “Space” button to activate last used command. 

6. Press the up-arrow and down-arrow keys to cycle through the stack of commands that 

you’ve used recently. 

7. Try to think ahead as you draw. This will enable you to do more things at the same 

time, and it will reduce down time needed for thinking before proceeding to the next 

task.  

8. To trim overlapping lines at corners, use the Fillet command with a “0” radius. If the 

fillet radius is set to round corners, remember that you can hold down on the Shift key 

to use Fillet as though the radius were set at "0" even though it is not. You will save 

the time required to reset the radius. 

9. Fillet two parallel lines to get an arc. 

10. To extend or trim try to select all as destination line or cutting edge by using Right 

click of mouse. Use Shift key to alter extend and trim command. 

11. Every command makes it faster to do something. Practice and remember such 

commands as Copy, Mirror, Stretch, and Array etc.  

12. Often Copy and Paste objects rather than recreating them. Even objects as simple as 

circles are often copied more quickly than drawing each one individually.  

13. Copy and Edit text, leader lines, and arrows rather than re-invoking the Text or 

Leader command and taking time to go through the basic options. Leader lines can 

very easily be adjusted by manipulating the grips.  

14. If a line or other object is drawn incorrectly, think first of correcting it by 

manipulating its grips. It is usually much faster than deleting it and redrawing it 

correctly. Don’t go slow for fear of making mistakes.  

15. Avoid switching back and forth between layers. Create everything on the layer that 

most objects will be on, and then at the end reassign objects to the correct layers. 

Reassign one object, and use Match Properties to reassign all other objects that should 

be on the same layer.  

16. Compete with yourself to increase drawing speed and efficiency.  

 

Courtesy: http://www2.hawaii.edu/~dmadden/acad%20tips.htm 
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Chapter 3 

Plan, Elevation and Section of a Building 

This chapter covers the application of AutoCAD as drawing tool of Civil engineering 

structures specially Building plans, elevations and sections. In this chapter plan of a masonry 

building has been presented first and elevation and section has been demonstrated based on 

that particular plan. This will enable student to understand practical use of AutoCad in Civil 

engineering. 

Necessary Drawing Tools: Line, Rectangle, Arc, Circle, Hatch, Text etc. 

Necessary Modifying Tools: Erase, Copy, Move, Mirror, Offset, Rotate, Trim, Extend, Fillet, 

Chamfer 
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Figure 3.1: Plan of a residential building 
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Figure 3.2: Front view of the building 
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Figure 3.3: Section 1-1 
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Chapter 4 

Reinforcement Detailing 

This chapter covers the application of AutoCad as a drawing tool of Civil engineering 

structures specially foundation, reinforcement detailing of slab, beam and stair. This will 

enable student to understand practical use of AutoCad in Civil engineering. 

Necessary Drawing Tools: Line, Rectangle, Arc, Circle, Hatch, Text etc. 

Necessary Modifying Tools: Erase, Copy, Move, Mirror, Offset, Rotate, Trim, Extend, Fillet, 

Chamfer etc. 
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Figure 4.1: Wall Footing and Column Footing 
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Figure 4.2: Reinforcement details of roof slab 
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Figure 4.3: Longitudinal and Cross section of beam 
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Figure 4.4: Reinforcement detailing of stair
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Chapter 5 

Plan, Section and Elevation of Slab Culvert 

From this Chapter Students will able to learn about different types of Culvert and they will be able to 

draw the plan and Sectional Elevation View of Slab Culvert by using different tools of AutoCAD. 

Figure 5.1: Plan of the Culvert. 
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Figure 5.2: Sectional Views of Culvert 
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Chapter 6 

Plan, Elevation and Section of an Underground Water Reservoir 

 

Figure 6.1: Plan of the underground water reservoir 
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Figure 6.2: Section A-A 
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Assignment 

 

Draw the following diagrams using AutoCAD (follow the instructions where given):  

 

1. 

 
 

2. 

 
Use Line, Arc / Polyline 

3. 

 
Use Line, Arc 

16' 6'

45°

45°

R3'

12'

10' 10'10'

45°

2'

2'
1'

1'

3'

10"

1"1.5"

1.5"

2.5"

2'-10"
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4. 

 
Use Rectangle , Line, Offset 

5. 

 
Use Copy(for donut) ,Hatch (Conc. ,Sand) 

1'-8" 1'-5" 1'-5" 1'-8"

4'3"

3"3" 3" 3"

3"

3"

3"

GL

4'

1'

3" 3"

3"3"

#5@ 5" C/C#6 @ 5" C/C
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6. 

 
 

 
Use Offset, Copy, Scale factor of Dimension Style 

Ground Floor

1st Floor

Roof

2nd Floor

3rd Floor

4th Floor

Base

6'

10'

10'

10'

10'

10'

18' 20' 18'

6'

4' 6"
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7. 

 
Use Center line 

12' 12'

12'

3'

12'

2'

2'-6"

7'-6"

4'

2'-6"

2'

4'4'

5"

5"
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8. 

 
Use Block 

12' 12'

12'

3'

12'
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9. 

 
Use Offset, Rectangular Array 

10. 

 
Use Offset, Polar Array 

1'

1'

1'

1'

1'-6" 1'-6" 1'-6" 1'-6"
R2"

Center

R3'
3"



Department of Civil Engineering  
AUST 

                                                             

 
CE 102: Computer Aided Drafting  

Page | 59  
 

11. 

 
Use Offset, Polar Array 

12. 

 
Use Polar Array 

R3'
3"

Center
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13. 

 
Use Offset, Trim, Hatch (brick) 

14. 

 
Use Hatch (Conc.) 

10"

2.5"2.5"

6"

6"

6"

6"

3" 30"

3'

2"

1'-6"

6"

1"

5"
1"

1"
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15. 

 
Use Line, Arc, Offset, Hatch 

 

 

 

  

6'

5'

3'
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